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My belief is that PowerPoint doesn’t kill meetings.
People kill meetings. But
using PowerPoint is like
having a loaded AK47 on the
table; you can do very bad
things with it.
Peter Norvig
Engineering Director,
Google, Inc.
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Getting Started
As you probably already know, PowerPoint is one of the most frequently
used software applications on the planet, with hundreds of millions of
people, in every imaginable occupation all around the globe, addicted to
its plodding simplicity. Giving a PowerPoint presentation is easy, right?
A toddler can do it. Your cat can do it … and maybe even your dog. Just
keep pressing the down arrow key and talking. That’s all you have to
do—slide after indistinguishable slide.
Well maybe anybody can treat PowerPoint like that, but it’s also one of
the best ways to look like an average, boring idiot in front of an audience. Fortunately you don’t want to look like an average, boring idiot or
you wouldn’t be reading this book series in the first place. You intrinsically know, or at least sense, that something better is possible, that those
humble PowerPoint slides represent enormous potential just waiting to
be harnessed. That potential is your ticket to becoming an amazingly effective speaker.
So, does that mean the purpose of this book series is to teach you better ways of using PowerPoint? Yes and no, actually. Yes I’ll entice your
frontal lobes with more techniques for using this software than you ever
imagined possible. And yet the core purpose of these books is really not
about learning PowerPoint per se. The real outcome is a better understanding of visual communication. Oh, and it just so happens that mastering PowerPoint is an integral (and in some cases a necessary evil) part of
that process.
Imagine trying to speak without a tongue for forming words. It’s like that
with Visual Language. You would have a hard time being a great visual
speaker without a convenient, affordable, easy-to-use tool that helps form
visual words. PowerPoint is that tool.
Therefore, yes. Becoming very, very comfortable and familiar with PowerPoint’s core operations is essential. Then I’ll take you well beyond its
typical uses into radically new applications. We’ll start in this book with
the basics and quickly move on to secrets that even most experienced
PowerPoint presenters never learn.
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What if you’re brand new to digital presentation and concerned you’ve
bitten off a little more than you can chew in this course? Don’t worry. Being completely new is perfectly alright. Initially we’ll start from the very
beginning with the most basic of tasks. You’ll be fine even if you’ve never
opened the software before.
On the other hand, it’s possible you’ve been a public speaker for years.
You already know your presentation software backwards and forwards,
right? Why bother continuing on with this basic-skills book? Shouldn’t
you jump ahead to the next book instead?
Nope. Think again. If like most experienced speakers, you’ve only begun
to explore PowerPoint’s hidden potential, and you probably don’t use its
tools very efficiently. I can almost guarantee, for example, that you don’t
know a lot of really important shortcuts and tips that simplify and speed
up important design tasks. It’s true that the next couple chapters might
seem a bit tedious in your case. Go ahead and skim through this early
material quickly, looking for any jewels not already known. And keep
reading from there. It’s inevitable you’ll find unexpected surprises along
the way, vital new tricks that save time and resources in the future.
For now I’ll assume you are a newbie opening the software for the first
time and starting with the basics. Realize, though, that by the time this
book’s final pages come into view you’ll know more about designing slide
shows than probably 99% of all people who do so regularly, regardless
of whether they’ve received formal training. You must know PowerPoint
that well before even considering going on to more advanced design and
navigation topics.
One final admonition: Be sure to stop reading regularly and actually DO
what you are reading. Have PowerPoint open and mimic every technique
taught on the spot. The “doing” helps you more readily remember those
strategies in the future. The more such core skills become embedded now,
the more time you’ll save later.
Plus, have an open mind. Don’t say, “You know, I’ve always done it
this other way and that works fine for me.” The methods recommended
here have been time-tested and honed over many years by thousands of
learners-becoming-experts just like you. Take this stuff seriously. Try the
suggestions I offer and let them become second nature. Resisting better
ways of doing things only wastes energy for absolutely no reason.
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PowerPoint
Versions
PowerPoint has gone through numerous versions over the years and you
may be wondering which version is best for maximizing visual design
skills. Very well, we might as well have that discussion.
Technically the version you happen to have at the moment doesn’t matter all that much. A great deal of the “radical new approach” you are
about to learn isn’t really new at all. Just about everything I’ll be teaching, in fact, has been possible since the late 90s. It’s funny, or maybe sad,
how few people realize the depth of potential that has been sitting there
dormant on their computer all this time. As such, don’t fret too much
about having the latest and greatest PowerPoint. Any modern version
will work.
Ah, but that said, Microsoft is Microsoft. Their designers have a talent for
screwing up every version in one way or another and then they hardly
ever get around to fixing those problems. As we go along I’ll walk you
through various bugs and inconsistencies that are either unique to each
version, or that carry through most or all versions. You’ll work around
those annoyances.
Here’s a little history about the software, along with my take on version
pros and cons. Microsoft bought PowerPoint from a company called
Forethought back in 1987. Not surprisingly, a lot of the program’s functionality has changed and improved since that time. Unfortunately, a
lot of it hasn’t changed much at all. The methods for adding hyperlinks,
for example, really haven’t varied noticeably in the last 15 years. I know
because that’s about when Visual Language methods got their start.
As a rule, the newer the software version the better. If you are still using
2003 or 2007, consider upgrading to 2010. PowerPoint 2013 is a notable
exception. As of the writing of this book, 2013 is such a complete disaster
(after nearly 2 years on the market) that I’ve actually gone back to working and presenting in 2010. Basically I’ve given up on the boneheads ever
fixing it properly. Version 2013 definitely IS NOT worth the upgrade from
2010. Yes eventually they will suck you into their new subscription marketing scheme soon enough and you’ll have to upgrade, but resist as long

6

as you can. Microsoft seems to be more worried about problems with
Windows 8 at the moment and maybe has placed the Office Suite somewhere on a back burner. Don’t expect 2013 to get better anytime soon.
And don’t think that switching over to a Mac computer helps either.
Theoretically you should be able to learn and apply Visual Language
techniques on a Mac, using a Mac version of PowerPoint such as 2008 or
2011. However, I wouldn’t waste my time doing so if I were you. Mac
versions of PowerPoint are poorly designed, in different ways compared
to their PC cousins. I’m aware you probably believe your Mac is better at
EVERYTHING because everything Apple does is better than Microsoft.
That fact may be true, but you will be disappointed with a Mac version of
PowerPoint when it comes to designing sophisticated dynamic content.
Stay with a PC and a PC version of PowerPoint if you value your sanity.
Despite my utter disgust for 2013, you’ll notice this Visual Language series includes 2013 screenshots throughout all the books. I wanted it to be
as current as possible. And in all fairness, some aspects of 2013’s design
are awesome, superior in fact. I sincerely hope its designers eventually
fix the current instability issues and a few other idiotic design decisions
you’ll hear about as we progress so that the awesome parts shine through.
Occasionally screenshots from earlier versions appear if procedures have
changed considerably from one version to the next.
In summary, stay with 2010 if you haven’t yet upgraded. I’ll say also that
you definitely should upgrade to at least 2010 if your presentation materials do—or will—contain a lot of video. Video has always been a problem
in PowerPoint but works much better in later versions. Ironically, 2013
handles Mp4 video somewhat better than 2010, and yet totally fails with
some older formats that have always worked before. Who knows why?
We’ll thoroughly explore these issues later in book 5: Media and Animations.
Note also that I intentionally shy away from including terminology
or functionality specific to a Windows 8 environment. That disastrous
operating system will go the way of Vista soon enough, to be spoken of
only in whispers. Screenshots here utilize a Windows 7 environment
instead. If you happen to be stuck with Windows 8 on your computer
and your view looks considerably different from the instructions shown
and explained on upcoming pages, try an Internet search for appropriate
Windows 8 tutorials.

7

The PowerPoint
Work Area
Upon opening PowerPoint
for the first time, you’ll
likely get an annoying
start screen. If so, click the
Blank Presentation option
at right to pull up a blank
standard white slide show
instead.
By the way, if you want to
get rid of that start screen
and automatically be taken
to a blank slide show, click
the Start button in the
upper right corner of the
PowerPoint window. Then
click the Options button
further down. At that point
you’ll be on the General
tab. There uncheck the
option to Show the Start
Screen at Startup. The next
time you open PowerPoint,
a blank slide show appears
automatically.
This new slide show, by
default, initially contains
only a single blank white
slide. You’ll normally go on
to add more slides as part of creating a presentation.
Let’s start by examining PowerPoint’s work area, what’s known as Edit
Mode or Normal View. Here’s where you make all changes to slide
shows. In other words, while preparing for a talk you’ll build everything
in Edit Mode and then switch to what’s known as Slide Show View
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while speaking to an
audience. In Slide Show
View, all editing tools
disappear and the audience sees nothing except
the content you want
them to see.
The work area’s largest
white rectangle—highlighted at left with a
red arrow—is called the
Slide Pane. That’s where
you place all content the
audience sees. Anything
sitting outside the Slide
Pane’s boundaries, out
in the gray area, does
not display during the
slide show. For example,
if you place a picture
on the Slide Pane, and
allow some of the picture to hang off in the
gray area, people do not
see that picture section.
The picture appears cut
off, as though cropped.
Certainly you can place
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items out in the gray area, but why would you want to do that? Why put
content where the audience can’t see it? Ah, that’s a fascinating topic we’ll
explore later. For now, make sure all normal visuals to be displayed stay
within the Slide Pane’s white boundaries.
By the way, don’t ever show Edit Mode to viewers if you can help it. Doing so is tacky, like showing your underwear. Always start the slide show
before people ever come into the room. We’ll look at starting, ending and
running the slide show in a moment.
Notice that Edit Mode has
several other zones as well.
The strip at the top is called
The Ribbon. This area
features various tabs full of
editing tools. Each click of
a tab reveals a different category of tools. For example, the Home tab contains
mostly text-related items,
whereas the Insert tab
features options for adding
other kinds of content to
the Slide Pane.
The zone to the left of the
Slide Pane is called the
Slide View Pane. It gives
you a snapshot of all the
slides in your show—either a text-based or image
thumbnail-based perspective. I always leave the
thumbnail view toggled
to see what the slides look
like.
Note that in earlier PowerPoint versions (before
2013), the Slide View Pane
can be closed by clicking
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the small “x” in its upper right
corner. They eliminated that
option in 2013, probably because
people tend to accidentally close
the pane and then wonder why
the heck they can’t see views of
their slides anymore—and subsequently wonder how to restore
the former view.

If that’s the case for you at the
moment —in other words you
don’t see the Slide View Pane—
restoring its visibility is easy.
Simply click the View tab on the
Ribbon and then click the Normal View button on this tab’s
left side. Try closing the pane
and opening it again for practice
if you have PowerPoint 2010 or
earlier.

The Slide View Pane can be
expanded or contracted as necessary to see larger (fewer) views
of slides, or smaller (more) views
of slides. To do so, hold your
cursor over the pane border until
the cursor changes to opposing arrows. At that point, leftclick and drag sideways with
the mouse. I typically leave the
thumbnails just big enough to
easily recognize the content.
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The Slide View Pane also has
a useful quality that comes
in handy while inserting and
adjusting content on the Slide
Pane. Remember a moment
ago I said that content hanging off into the gray area
outside the Slide Pane doesn’t
display to audiences, right?
That’s true. Unfortunately,
sometimes it’s hard for you
to tell exactly what they will
see—or won’t see—merely by
looking at the Slide Pane.
Imagine, for example, I zoom
way in on Slide Pane content
until I see only a small portion
of the picture, as shown in
the screenshot at right. Keep
in mind that I’m not changing the position or size of the
picture at all. It’s still sitting
on the Slide Pane exactly as
shown in the upper screenshot. I’m merely looking at the
picture in closer detail while
in Edit Mode. (We’ll discuss
zooming in on the Slide Pane
in a moment).
Looking at the Slide Pane in the second screenshot tempts us to think that
what we are seeing here is what the audience will see as well once the
slide show starts. But that’s not the case. A zoomed in view of content in
Edit Mode certainly does give you, the designer, a better perspective of
detail but is not an accurate signal of what displays to people. Fortunately, a quick glance over at the Slide View thumbnail (indicated above by
the red arrow) always does provide an accurate perspective, regardless
of how much you happen to be zoomed in or out while editing the show.
Get in the habit of constantly looking over at that thumbnail for a true
sense of what will be visible.
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Turn attention now to the
small icons in the bottom
right corner of the work
area. Hold your cursor over
the first one and see that
it displays a screentip of
Normal. Clicking this icon
does the same thing as the
Normal View button on the
Ribbon’s View tab that I
mentioned earlier.
The next icon to the right
toggles what’s known as
Slide Sorter View. Slide
Sorter View temporarily
hides the Slide Pane and
provides a larger area to see
thumbnails of all the slides
in the show. It’s a convenient way of finding and rearranging individual slides.
Try toggling that view now.
In the slide show depicted
below you can see thumbnails of all it’s slides while in
Slide Sorter View. This view
is adjustable to see more or
less thumbnails and bigger or smaller views of the
slides. To exit Slide Sorter
View and return to Normal
View, with the single strip
of thumbnails down the left
side, simply double-click
any of the slide thumbnails.
PowerPoint automatically returns you to Normal
View, with that slide selected and ready for editing.
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To change the view magnification while in either
Slide Sorter View or Normal
View, adjust the View Slider
(Zoom) to the right of these
icons. This slider allows you
to focus way in on minute
details, such as whether or
not objects are touching each
other, or way out to see the
big picture. Make adjustments to zoom in either of
three ways: Click and drag
the slider sideways, left-click
anywhere along the slider
track to immediately set that
zoom position, or click the “+” or “-” symbols.
As we’ll see later, zooming in on the Slide Pane is very useful, in part
because doing so helps you better see what you’re doing when making
fine adjustments and in part because PowerPoint’s alignment tools work
better when operating in a zoomed-in environment. You’ll get used to
zooming in and out on a regular basis.
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The remaining icon in this
bottom group, that looks
kind of like a wine glass, is
one method for starting the
slide show—that is, leaving Edit Mode and entering
Slide Show View. Clicking
this icon temporarily hides
the work area and displays
only the visuals you place in
the Slide Pane area. Clicking
that icon right now, before
you’ve inserted anything
onto the slide, results in a
simple white, blank display.

To stop the slide show (exit Slide Show View), either press the Escape key
located in the upper left corner of your keyboard or right-click the Slide
Pane and choose End Show from the menu options. Either action returns
you to the show’s Edit Mode.
You probably noticed that the slide text which is clearly visible in Edit
Mode, such as “Click to add title” doesn’t display once the slide show
running. We’ll discuss that situation and these special textboxes soon
while actually adding content to slides. For the moment we’re simply
playing with PowerPoint’s interface tools.
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The final zone in the work area, at the very bottom, is called the Notes
Pane. You might wish to type speaker notes here as a way of practicing
what to say when each slide displays. Keep in mind, though, that these
notes do not display to the audience and you likewise won’t see them
while presenting.
That’s a good thing in
my opinion. Speakers
shouldn’t see them while
presenting. Anyone who is
so dependent upon notes
that they have to read what
they’re supposed to say
absolutely does not belong
in front of an audience.
Having notes available for
practice, or for the benefit
of others who might end
up using your slides, is one
thing. Don’t EVER literally
read such notes during an
actual performance. Take the time in advance to practice sufficiently to
know what you’re talking about.
I’m reluctant to even mention another feature called Presenter View that
does allow you to see and read your notes, without displaying such text
to the audience. Microsoft seems to think Presenter View is the best thing
since beer, which pretty my sums up why digital presentation is in such
a pathetic state these days. It’s not that using notes during a talk is inherently wrong. I and other regular speakers sometimes rely on basic outlines to assure all key topics have been covered. My beef with Presenter
View is that it encourages people to literally type out what they want to
say and spew forth with that script like robots while talking. It’s sick and
wrong.
At any rate, if you do decide to add notes to slides, the writable area can
be expanded by clicking and dragging this pane’s border. That gives
more space. Probably the best use for this area, in my opinion, is if you
are building presentation materials for other people to adopt and need a
convenient way of conveying slide purposes they can study on their own
time.
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